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CBM means different things to different people

Incipient Failure Detection

Condition Monitoring

Sybtem C M M S
Pl

Condition Assessment
. . CA = F1(ll@)| E7(M2" U“S.i:f;
CBM Preventive Maintenance ! ] o |
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The 6 Steps of CBM with the Pl System
@

Notifications @

Event Frames ®

Analysis O,Q
O

Pl Asset
Framework

Pl Data
Archive

@

Pl Server

Pl Interfaces & Pl Connectors

®

Microsoft®

Pl Integrators & Eﬁ SQLServer
Pl System Access
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1. Connect to relevant sources

N Gsas
ORACLE

JDEdwards
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2. Collect and archive data

3. Assign context (asset-based)

4. Execute condition monitoring logic

5. Visualize real-time conditions

6. Alert and notify
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\ .

Pl Visualization
Suite
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http://www.sap.com/index.epx
http://www.sap.com/index.epx

Data Flow and Pl System Tools
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Condition Monitoring with PI

=} (§ Balance of Plant
B Feedwater System
i (J Boiler Feed Pump #1
b (5 Boiler Feed Pump %2
- (J Generator
- @ Mills
- (J Turbine
;2 RunHours_Report Power Plant
Power Generation Filia Power Plant
on and Distribution dro Power Plant
es

d Power Plant

Air Heater
Balance of Plant
- (J) Feedwater System
i (J Boiler Feed Pump #1
i (J Boiler Feed Pump #2
Generator
Mills
Turbine
lours_Report
seneration Fleet
distribution

re

2 mils

B | =] Bearing Vibration High Limit
B | =] Control Oil Pressure Low Limit | 32 psi
® 1700 k Ib/hr

=] Discharge Flow Low Limit

E BB B B
IIIIIE

Boiler Feed Pump High Bearing Temperature
Boiler Feed Pump Low Discharge Flow Anomaly
Boiler Feed Pump Low Pump Speed

Boiler Feed Pump Suction Pressure Anomaly
Boiler Feed Pump Vibration Anomaly

- 0000

Event Frame Template: | Boiler Feed Pump Vibration Anoma'ly

Name Expression !
OutboardYFault| 'Outboard Bearing Vibration Y' > Limit
StartTrigger |if InboardXFault or InboardYFault or OutboardXFa

Evaluated at 3/29/2015 7:10:46 PM

© Copyright 2016 OSlsoft, LLC 6




Notify asset owner — include links to displays

From: DoNotReply@0SIsoft_PINotif.com [mailto:DoNotRe ply@05isoft_PINotif.com)

Sent: Thursday, September 25, 2014 7:00 AM

T  ee—

Subject: Production KPIs] generated a new notification event.
Name: Daily Production KPIs

Trigger Time: 97252014 6:00:00 AM Central Daylight Tume (GMT-05:00:00)
Unit: Batch Operation

In the Last 24 hours:
Cycles = 259 count

Downtime =2 583333 h

i+ Feed1 =43062.45US gal

Feed2 =20236.69 US gal

http://dfpicoresight/Coresight/#/PBDisplays/10073

0S'soft. opyright 2016 OSlsoft, LLC



http://dfpicoresight/Coresight/#/PBDisplays/10073

Linked Pl System display from Notifications

i Boiler Feedpump Overview Ad Hoc Display
oresig .
) Boiler Feed Water Pumps | nseie PR | [ aenerator | (NGRS
(-] Pump #1 s > = Main Steam Flow

29.12 k Ib/hr

Al X-protes BFP Steam Turbine Trends Coupling Trends Pump Trends

Main Steam Flow
Pump #2 28.21 k Ib/hr

|a= ¥~=-=°"I BFP Steam Turbine Trends Coupling Trends Pump Trends

[ o] =l ] ) e o] ] o] ] (] ] [

3/25/2015 7:31:06 AM < 1d > ﬁ 3/26/2015 7:31:06 AM
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Pl Asset Analytics can be used to create Event Frames

Event Frames
Analyze Events over time

Find common cause/failure
modes

Report on efficiency

Search Start
Search En

Pump Information [Pl AF]

1/10/2014 0:00

10-Jan-14 00:00:00
24-Mar-14 14:17:41

site tame[San Leandro Power Plant
Unit Niame | Unit 1
Pump NamelBDiler Feed Pump #1

Vibration Y|

Vibration X|

mils|

mils| mils|
135 ] 150 1.55
o.13[1 0.0l 0.05

uom
Value at Start: 10-Jan-14 00:00:00 [ |
Value at End: 24-Mar-14 14:17:41 ]
——

0.05]1 0.04 0.04
1ol ] 1 [ 1 1.26]
21.00] I 21 1.28]
2.22 [ ] oss[MEE | 0.62

Pump Events [Pl EF] (281)

EF NAME

EYENT CATEGORY

Minimum
Average
StdDev

Minimum
Average
StdDev

Event name

Start time

End time|

Boiler Feed Pump #1 - Boiler Feed Pun|

10-Jan-14 00:00:00

11-Jan-14 06:40:00

Duration |Event:
16:40:00| Boiler Feed Pump Low Discharge Flow
K] taoCanaD. o - 1

Boiler Feed Pump #1 - Boiler Feed Pun|

10-Jan-14 00:00:00

11-Jan-14 06:40:00

Boiler Feed Pump #1 - Boiler Feed Purn]

Boiler Feed Pump #1 - Boiler Feed Pum) 10-Jan-14 00:00:00

10-Jan-14 00:00:00

10-Jan-14 00:55:00

10-Jan-14 00:55:00]

Boiler Feed Pump #1 - Boiler Feed Pur]

10-Jan-14 06:35:00

10-Jan-14 07:00:00|

Boiler Feed Pump #1 - Boiler Feed Pun|

10-Jan-14 06:35:00

10-Jan-14 07:00:00

Boiler Feed Pump #1 - Boiler Feed Pun|

10-Jan-1409:35:00

11-Jan-14 11:30:00

Boiler Feed Pump #1 - Boiler Feed Pum|

10-Jan-1409:35:00

11-Jan-1411:30:00[ |

281 <<Boiler Feed Pump #1>> Events

”3 OSlsoft.

10-Jan-14 11:45:00

10-Jan-14 11:45:00

10J2n-12 12:05:00

10-Jan-141 00

11-Jan-14 01:30:00

11-Jan-14 01:50:00

76 —2014_01_25-—- Events poier Feed Pump

Unit TIME. DReger Feed Pump
PowertantEugin n 0 earing Temp, 2
0

PowerPiantStartl
p0

Unie
Trip,
4

Mill Low Feeder
Speed, 47

Cantrol Oil Pressure
Anomaly, 2

Bailer Feed Pump
LR T
Discharge Flow, 4
Boder Feed Pump
Low Pump Speed.
Boiler Fled Pump
Suction Pressure
Anomaly, 0

Boiler Feed
Pump
Vibeation
Anomaly, O
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Framing data - Start/End of a time window...

A
&
Define your EVGI’]tS H Pl EF (Microsoft SQL)

mgﬂ

Batch ' "'

Referenced| Referenc

) Tur ) H

Attributes Attributes Attributes

<7 Recipe
Res Avera
< &g & 7 Product

Devi
d Cor\@f evia & Feed Source/

Referenced Asset(s)
3} Mixer PM31
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Analytics Outcomes

I---
oF

Insights

- Operational Insight
- Unsuspected or Validated Correlation
- Multivariate analysis

"Wilelglitelgligle;

- Limit, Rate of Change
- Efficiency, Performance, Accumulation
- Pattern Recognition

Use PI (time-series) data within IT

- Variety of data correlation
- Transform Business Process
- KPI Reporting (BI)

© Copyright 2016 OSlsoft, LLC
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PSE&G: Condition Based Maintenance and Asset Management ¥ OSlsoft

POWER & UTILITIES

N
(ng OSlsoft.

“We get a detailed breakdown on
equipment costs and man/hours to
service that gives us important business
benefits. Without the use of the Pl
System, it would have taken us several
months to gather and analyze the
information.”

Angela Rothweiler, Principal Engin€ 1 0¢

Customer Business Challenge Solution Customer Results / Benefits

- Providing the highest reliability L";glﬁgﬁ?égﬂ 2;’:22’22; g;\ta collection « Holds Reliability award for Mid

Power Distribution is requirement Atlantic States for last 7 years

Set up standard business rules for
condition based maintenance using the
Pl System Analytics

* Minimize Maintenance Costs * Named most reliable Power

Company in America

» Focused maintenance expenditures

Provided focused view into equipment
on needed targets

Provided Financial access to data by
Business Objects query

Copyright 2016 OSlsoft, LLC
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Calculation Approach

e Calculation Structure
— CA=F1(M1) + F2(M2) + F3(M3) + ...
— Factors driven by data available
— Example Factors
*« CM Cost & Count for Past 6 Months
« Operation Count for Past 6/12 Months
« Gas Analysis — Change over time
« Average Load over Time
« Peer Groups
— Apply calculations by peer group
— Voltage, Class, Type
— Example Groups:
« 26KV - 69KV GCB
* 138KV+ Power Transformer
 LTC Vacuum Tanks

© Copyright 2016 OSlsoft, LLC



CBM data sources (T&D example) ™ PSEG

We make things work for you.

Distribution
SCADA

\;

Ml
&

= Electrical results
Transmission iy | o T — ‘
SCADA | Breaker Tests p—
| HDW Q§ E
- > '
[ §
ESOC Pl

: - Diagnostic data L
) OSlsoft.
© /
— \ \Delta-X

Tra nsformer

= ;. oil analysis
|| Hydran L

Gas equipment CMMS order history
sults Asset registry updates

Transformer
Ioads /

MV90

Weekly subtation
inspection
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Asset health score 3 PSEG

We make things work for you.

I]m;smw Iinjrwidev29 Asseto20Manag ebPages/LtcsCA-Ad New.aspx

7% Home Documents and Lists Create Site Settings Help

O PSEG LTC CA-Action New Summary Report

CA Records

*O= Equipment Equip Descr Score Person

Details Division Floc

= ::E:;:_: 000000000010504694 Load Tap Changer (UVT)

e weces 000000000010505424 Load Tap Changer A (LRS700)

e ::i :: s 000000000010526193 Load Tap Changer SEL 220-1

m  wenwe 000000000010507132 Load Tap Changer

« s 000000000010505426 Load Tap Changer C (LRS700)

m  venss 000000000010505430 Load Tap Changer C (LRS700)

CE IPE-CE-G!

© reox 000000000010505427 Load Tao Chanaer A (LRS700)

L~ - -~~~ - - -

SO IPE-SO-SNF -4TRX 500-4 Transformer 000000000010523970 Load Tap Changer S00-4A

o) IPE-SO-MRO -T1 # 1 Transformer 000000000010525854 Load Tap Changer 25 Mark Pending Action |
PA IPE-PA-HOM -T3 # 3 Transformer 000000000010515806 Load Tap Changer 24 |
CE IPE-CE-SDN -3TRX S00-3 Transformer 000000000010505433 Load Tap Changer C (LRS700) 24  Paul Pending Action |

http://videostar.osisoft.com/Regional_Seminars/2009/Boston/Video/RS2009_Boston_CBM_PSEG_Gopal_Rothweiler.wmv

© Copyright 2016 OSlsoft, LLC
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Asset health score - details & PSEG

We make things work for you.
2§ Web Part Page - Microsoft Internet Explorer

ks
I

| B Edt Vew Favorkes Dods Hep
= ; = T—— = = = = = = =

[ Qe+ @ - [ @) (] Psewch o'sFaontes @ [ (30

JAgdvess @ i hsset es/LTC 1 aspixPeq=

Algorithm Factors

O PSEG LTC CA New Action Algorithm [
';:':\‘l::ht;lwsmn Station Code  Station Station Type Fam:lr Haw 'h"-!l|l.lt E'asﬂ '||I'-!|I.IE wﬁ":ht % Emrﬂ

Z.K:mm E::::a\\h:::ﬂ POLHEMUS LANE  H DEtEI:taHE A':ETI.IE“E 4915 _ ] i

Gas Rate of Change 6.03 5 15 0.75

¥ C LTC New Action Algorithm Rules

High Tatal Gas 270243 I - 2

Factor Raw Value Case \ H' h wate 43 n 1ﬂ
Detectable Acetylene 4915 |g r

Gas Rate of Change 6.08 5

e o e Lo Dielectric 344 ] 10

=

[

Low Dielectric 344 0 -

LTC Operations 95 0 LTE ﬂperﬁhuns gE u 113
LTC THRU MEUTRAL 1

= D O O

~ LTC THRU HEUTRAL 1 ET 10

Score maxScare Ranking(%)
£.25 6.25

RtTrend

CA SCore -

Score maxscore Ranking{%) Peer Group
6,25 f.25 100 VACUUM

< LTe 01/14/1998
o LTe 03/10/1337 424 424
Shawing L to 5 of §

6 Months Counter Dperations A

==l
[&] Done [ T[] 8 Localintranet
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Benefits Summary

. More targeted capital expenditures with
eventual overall reductions

CAPITAL
. . . . . EXPENDITURES
* Asincipient failures are reduced, corrective CAPITAL
. EXPENDITURES
maintenance costs go down CAPITAL
o ey s . INCIPIENT INCIPIENT SRR
. With a move to condition-based maintenance, CORRECTIVE CORRECTIVE
K . . MAINTENANCE MAINTENANCE INCIPIENT
calendar-based preventive maintenance is CORRECTIVE
CONDITION-BASED
. oype .o . |
. Automation of condition-based notifications T
CALENDAR-BASED MAINTENANCE

(emails, pages, maintenance notifications, etc.)

*  Codification of organizational intelligence into
condition-based algorithms

PREVENTIVE
MAINTENANCE

CALENDAR-BASED
PREVENTIVE
MAINTENANCE

. Prioritization of maintenance, shorter e
downtimes, do the right work at the right time §
. Improved visualization of asset health status

. Improved decision making capabilities

ﬂl' v

9
b

EEseE
33:135
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SDG&E Technical Overview

Transformers

lntorll"lﬁo’r;i .
Eloctrical Devices
Localized processing

Breakers

Intelligent
Eloctrical Devices
Localized processing

Substation

&

Backhaul

Back Office

Reoquired Communication
Protocols between IED's
and the Control House
CBM Gateway:

1) MODBUS
2) DNP3.0

Physical pathways between
1ED's and the Control House
CBM Gatoway (possible
methods):

This could include:

=  Substation WAN circuits
- Data Center WAN circuits

- Network routers and firewalls in
Substations and the Data Center

- Intrusion Detection/Prevention

CBM Analytics

Possible WAN communication

@

L CBM Server

Communication
from Monitors to CBM
Gatoway

Engineer & Construct all
selected substation components
(no procurement)

CBM Gateway polls IED's,

requirements and -m;
historical data for further use.

methods:
1) Wireless with 256b Encryption
2) RS485 - 86K or T1 dedicated circuit
3J) BPL with 256b Encryption - Fractional T1 Frame Relay
4) CATS Ethernet - Broadband wireless
5) Fiber - Fiber optic
Substation Control House WAN
communications

D ==y
MODBUS cem TOPIE
DNP Gatoway

> i — 7 — -

Data transmitted o
|

level gateway
by time trigger or
exception basis

=S

A Q)Scmpra Energy utility” ‘ol Gateway

-~
SDGE

OSlsoft.
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Condition Monitoring Examples

- Transformer
« Detect Loss of Cooling Fans/Pumps
+ Detect Failed Control Contactor for Cooling Fans/Pumps
« Collect Data on Run Hours for Fans/Pumps
« Oil Temperature (Top & Bottom)
+  Winding Hot Spot Temperature (Calculated)
« LV Load Current
«  Ambient Temperature
« Eight gas DGA
« Cooling System Manager / Monitor
« HV Bushing Power Factor
« LV Bushing Power Factor
« LTC Position Indication & Operations Counter
« LTC Motor Energy
« Conservator Integrity
» Provide Break-Out of Miscellaneous Bank Alarms

- Breakers
« Gas Pressure / Density

« Ambient Temperature
« Air Compressor / Hydraulic Motor Hour Meter (optional-not in use)

© Copyright 2016 OSlsoft, LLC




Pl Visualization

“Fovorkes €3 | (o~ o i~ ~ o

uments/ Overview.aspx7RETreeView_SelectedNode Tag=\lap-cbmpi-s01imdl: SOGE_CBM_Di

201 %205 DY 20(5 O

&’ sempra Encray” Electric Substation Condi

ion Based Maintenance [Thi= Site: Electric Substation C1_=]|

Reports:| Tools Documentstion — Cantacts

Electric Substation Condition Based Maintenance > Reports > TransformerOverview

i Transformer Overview

@ Report Time Range

StartTime [F5g —— a EndTime [ 5 Lapely| L¢3 el
@ substation Navigation ~ @ Transformer = @ Alarms -
= @ Distributech - A =] =] 5| 51
SiEahSaUoD A1) Descriptor Time _l Tlll:J
e jtransformers {53) HoDatn HIGH OIL MAIN TANK ALARM 2/5/2009 :04:00 PM 1
@ Distribution (S1) v NOT APPLICABLE 1 C2
@ LTC Transformes WINDING GAUGE HIGH TEMP1 ALARM 1
 BK-30 NOT APPLICABLE ==
 F S TOP OIL GAUGE1L NOTIFICATION STATE 2/5/2009 5:04:01 PM 1
- -t b Showing 1 to S of 16
o ——— ;[_j

@ Transfomer Trends

wanetonmer CALT
wanstormer AMBIE

¥

Degrees (Centigrade)

°
1/3172008 5:05:40 PM

ALCLILATED WANDHNG
& AMBIENT TEMP

=l Transformer Data =

Open ~ | Updste = | 33 Fnd ‘ PORE— E———
Transformer Overview Eng
ime Vvalue Units
LV phase A current 0S5-Feb-09 14:05:32 669.0 Amps
LV phase B current 0S-Feb-09 14:02:16 656.0
LV phase C current 0S-Feb- H 699.0
Ambient temperature 0S-Feb-09 13:51:03 21.5
Calculated top oil temp 0S5-Feb-09 13:1 7 S8.5
Oil temperature for main tank 04-Feb-09 21:5: 26.9
Oil temperature for LTC tank 04-Feb-09 19:5S 24.9
Condition code for main tank 0S-Feb-09 14:0° o
Disgnosis text for main tank 0S-Feb-09 14:0! o
Condition code for LTC tank 05-Feb-09 14:0 o
&) Done

Histare| | (3 & |[&7 Reports - Transforme...
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Pl Visualization

nzoisDW =] 3 G0
;

it
@Scmpm Energy” Electric Substation Condition Based Maintenance

[This Site: Electric Substation € =] B - 2|
Reportss| Tools Documentstion  Contacts -
Electric Substation C. Based nce > Reports > DissolvedGasAnalysis

il Dissolved Gas Analysis

@ Report Time Range

Start Time [s.sq  § EndTime [ fuc| apply | o3| «| »]
@ substation Navigation - @ pDGA - @ Alarms -
Sibutech — e = Descriptor Time value
Substation 1 (S1) o (=< =} T DGA CONDITION CODE FOR SOURCE A 2/5/2009 5:08:00 PM
e Transformers (S1) ° DGA CONDITION CODE FOR SOURCE B 2/5/2009 5:08:00 PM 1
@ Distribution (S1) NOT APPLICABLE 12/3/2008 9:18:30 AM -
@ LTC Transformers (S1 Dis

= @ Main Tank Gas Concentrations

BK 30 Bushing
BK 30 DGA

30 LTC

BK 30 Predictive Ar
BK 30 Thermal

4 @ BK 31 5
1| —— _>l'_|

e BK 30 Y
°

LB L
-]
=

o
173172009 5:08:49 PA 5 Day(s)
© ETHYLENE CONC. FOR A

@ Diverter Tank Gas Concentrations

B -
17312000 5:08-37 PM 5 Dayie)

® ETHYLENE CONC. FOR B

=l DGA Data =

BT AR — —

Aistart| | (3 & |[&7 Reports - DissolvedG...
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OSlsoft Partner Ecosphere

Partner Types

System Integrator

OSlsoft.

SYSTEM INTEGRATOR
PARTNER

System Integrator's (S1's) are partners who provide a variety of services, such as implementation and integration, strategic
consulting, configuration, application

Application

OSlsoft.

Application partners or Independent Software Vendors are partners that provide their own software applications and products

:;;T::s: which integrate and extend the Pl System to provide additional functionality for customers.

Technology

Technology partners provide products and services with demonstrated interoperability with OSlIsoft's technologies and
demonstrated relevance to OSlsoft's customers.

PARTNER

Copyright 2016 OSlsoft, LLC




Roadmap to Readiness Resources

e WWW.OSisoft.com/corporate/business-analytics

e https://techsupport.osisoft.com/Products/Product-
Roadmap

e http://pages.osisoft.com/Business-Analytics.html
* Learning channel, techcon, AF Example Kits, SPOC, etc.

© Copyright 2016 OSlsoft, LLC
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CBM Prescriptive Guidance

osi Terms & Definitions

TR IR Implementation Guidance

Condition-Based Maintenance
(CBM) Using Real-time Data

A practical guide to getting more value from real-time data P I Svste m Ove rVi eW fo r C B M

by supporting asset management systems

Condition-Based Maintenance

/\ 7\& conditon momtorng Pl System Integration w/ CMMS

Decision Support

/
}
ﬁ///w Enterprise Integration Enablinq ODDO rtunities

Business Intelligence

Solution Examples

Link: http://pages.osisoft.com/rs/osisoftlic/images/CBM%20Guidebook.pdf I n d u StrV Refe rences

© Copyright 2016 OSlsoft, LLC
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Predictive Analytics




Statistical Modelling - Predict Asset Failure

Complex systems; descriptive @ MATLAB e puthon’

equations are too numerous and G
interrelated. (8]c szszms
(61, Failure
* Create an operationalized model to 8 N
reduce unplanned downtime for ol Lo L
100 engines. o5 T Failure
ki Tl
* Extract data for 2,300 sensors —n i 1t JJ "
leading up to engine failures. i) | i TRt
* Developed a statistical model using
R for predicting failure. s

* Tested and operationalized for all e
engines against historical data. - —

All Engines

© Copyright 2016 OSlsoft, LLC 26




Predictive Modelling Process - Example

Using data taken from 100 engine failures, develop and operationalize a
model for predicting failure to avoid unplanned downtime in real time.

Step 1- Use AF Analytics to create Event Frames for engine operating periods.

Step 2 - Publish a text file “Event View” dataset from the Pl AF
using the PI Integrator for Business Analytics (BA).

Step 3 - Use the functionality of R to analyze this dataset and to develop a
qualified predictive model for determining remaining useful life (RUL).

Step 4 - Implement the predictive model in AF Analytics, at scale,
for all 100 engines.

Step 5 - Evaluate the predictive model using the Pl Integrator for BA
and Power Bl Desktop.

© Copyright 2016 OSlsoft, LLC



Step 1
Pl Analytics to create Event Frames

© Copyright 2016 OSlsoft, LLC



Lab Pl System and AF Model “Engines”

@ \\CHERTLER7450\Engines - PI System Explorer - O X
File Search View Go Tools Help
(@ Database [ Query Date - ® @ | @ Back () |8, Checkin %2 + &) Refresh |3 New Element - ‘] New Attribute
.
* Actual data for 100 engines =
& elements ~ || General child Elements Attributes Ports  Analyses Version
— @ Engine_1 Excluded attributes are hidden. Group by: [/] Category [_] Template
— @@ Engine_10
Fiter h
— (@ Engine_100 ‘ 7 2 -
° 21 . # ¢ m & R name 4 value @ |~
sensors B ergne 1 ] @]
& Engine_12
. @ Engine_13 N A
b 3 tt & Engine_14 .
Se I n S & Engine_15 L & 52 643.54 °R
3 Engine_16 ® Fs 1601.41 °R
Engine_17
& Engine_18 = & A 1427.2 °R
& Engine_19 m & s5 14.62 psa
— @ Engine_2 ® & 6 2161
— @ Engine_20 - sodrr
— @ Engine_21 L] & s7 551.25 psia
~ @ Engine_22 L] & 8 2388.32 rpm
— @ Engine_23 =
— (@ Engine_24 . i) TN
— @ Engine_25 L & s10 13
- (@ Engine_26 [ ] & s11 48.25
- (@ Engine_27 o
&
- & Engine_z8 ] & s12 520.08
& Engine_29 L] & s13 2388.32 rpm
& Engine_3 L] & s14 8110.93 rpm
E 30
; fngne 31 s 15 85113
£ Engine_32 L] & s16 0.03
& Engine_33 [ ] & 517 396
& Engine_34
& Engine_35 " & s18 Lo
& Engine_36 Ll & s19 100
& Engine_37 v 4 & 20 38.48
a n & s21 22.9649
i Event Frames. B =) Category: Engine Setting
1 Library L} & settingl 0.0009
Unit of Measure . & setting2 o
ﬂ Analyses = @ setting3 100 .
|30 Attributes

*A. Saxena, K. Goebel, D. Simon, and N. Eklund, “Damage Propagation Modeling for Aircraft Engine Run-to-Failure Simulation”, in the Proceedings of the Ist International Conference
on Prognostics and Health Management (PHMO08), Denver CO, Oct 2008.

OSlsoft. Copyright 2016 OSlsoft, LLC



Lab Pl System and AF Model “Engines”

e Actual data for 100 engines

e 21sensors
* 3 settings

* Operating time to failure varies

» Start time is always 2/21/16 12 am
* Failure times are no later than
2/21/16 7:00 am

* Operating status

*  “Running”, “Failed”, “Stopped”

*A. Saxena, K. Goebel, D. Simon, and N. Eklund, “Damage Propagation Modeling for Aircraft Engine Run-to-Failure Simulation”, in the Proceedings of the Ist International Conference

on Prognostics and Health Management (PHMO08), Denver CO, Oct 2008.

OSlsoft.

Q

File Search View Go Tools Help
@Database [ Query Date = (© @ @Bacl-c > ] a‘f CheckIn *2 « |&#]Refresh | (3 Mew Element =

WPISEVO1\Engines - Pl

Elermnents

&Y Elements

- @ Engne_1
o @ Engine_10
& Engne_100
& Engne_11
3 Engne_12
(3 Engrne_13
& Engne_14
& Engne_15
(5 Engne_16
(& Engne_17
& Engne_18
& Engne_19
& Engire_2
& Engne_20
& Engne_21
& Engine_22
& Engne_23
@ Engne_24
5 Engne_25
(3 Enarne_26
& Engine_27
& Engne_23
(5 Engne_29

L @ Enaine 3

A

Elements

Search

= 2y Name

< Description

8 |5 Engne_1

jEng'ng Template

& Engine_10

Engine Template

&=

2]

=]

B | @ Engine_100

Engine Template

& Engine_11
(3 Engne_12
& Engine_13
Trend

Engine Template
Ergine Template
Engine Template

_l:l-

StartTime: [2/20/2016 11:53 PM

# Engine_1 |Status O Engine_1|s21

3 @35

JE=[* ] endTime: [2/2172016 7:00 am
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Event Frames for Engine Failure

@ \\CHERTLER7450\Engines - PI System Explorer - o X
File Search View Go Tools Help
@ Database [ Query Date - ®© @ @ Back #, Checkin *3 ¢ (2] Refresh 1 F New Element ~ Search Elements o~
* Create Event Frame template. e 1
& Elements ~ || General child Elements Attributes Ports  Analyses version
g E:Z:::::o & > Name: Failure Event Frames
& Engine_100 o m @& Name Backfilling Description:
° A d d « E F G . 9 s o @ ® % Engine Failure Prediction | cotegoris: -
vent Frame Generation e @ N e :
& Engine_14 @ ® H Failure Event Frames Anshyss Type: it o
. 113 3 1) @ Engine_15 ® Event Frame Generation
analysis to “Engine” template
* @ Engine_17
& Engine_18
. ¢ ) “ 2 3 E:Z::::;g Event Frame Template:  Engine Failure ‘ Functions
° Sta rtT rl g g e r: Statu S = Sta rte d -’ Engine 20 /B & Name 2/21/2016 ... [06:01:00) 2/21/2016 .4 Duraton  Start Time EndTme & ~
; ::3::::;; e o ¢ | F=Engne 39 [R— 2007:00 | 2/21/2016 12:00:00 AM 212112016 2:07:0(
° E n dT ri g g e r. ¢ Statu S ’ — (3 Fa i | ed ” & Engine23 # | Engne o1 — 2:14:00  2/21/2016 12:00:00 AM 2/21/2016 2:14:0(
. @ Engine_24 StartTrigger| 'Status'="Started" + = Engine_57 | 2:16:00 2/21/2016 12:00:00 AM 2/21/2016 2:16:0(
f’ Engine_25 e stotus - reiled # | ==Engne 70 [ 2:16:00  2/21/2016 12:00:00 AM 2/21/2016 2:16:0(
‘; :::[::—;: N - s+ b= Engne_24 — 2:26:00 2/21/2016 12:00:00 AM 2/21/2016 2:26:0(
& Engine 28 r # | F=Engne_s8 — 2:26:00  2/21/2016 12:00:00 AM 2/21/2016 2:26:0(
. & Engine_29 # |—Engnes B 2:29:00 | 2/21/2016 12:00:00 AM 2/21/2016 2:29:01
[ B a C kﬁ I I a n a Iys I S to g e n e rate & Engine_3 StartTrigger true for: 0 Minutes ¢ |m=Engness | E— 2:32:00  |2/21/2016 12:00:00 AM 27212016 2:32:0(
& Engine_30 A - b= Engine_77 S 2:33:00  2/21/2016 12:00:00 AM 2/21/2016 2:33:0(
& Engine_31 Generate child root cause event frame be|
. S o ®+ | = Engne 90 e — 2:33:00  |2/21/2016 12:00:00 AM 2/21/2016 2:33:0(
Eve nt F ra m e S fo r e a C h e n g I n e . & Engine_33 % Duration: Minutes 4+ | = Engnes3 —_— 23400 2/21/2016 12:00:00 AM 2(21/2016 2:34:0(
Name:  Root Cause ® ¢+ | Engne 27 b 2:35:00 | 2/21/2016 12:00:00 AM 202112016 2:35:0(
J Elements Catigry: m ¢ |F=Engne_os ——— 2:35:00  2/21/2016 12:00:00 AM 2/21/2016
— Event Frames | b= Engne_19 | 2:37:00 2/21/2016 12:00:00 AM 22112016
113 Library ®+ | Engne_36 —_ 2:37:00  |2/21/2016 12:00:00 AM 2/21/2016 2:37:0(
L Ui ot Ve ® Event-Triggered () Periodidy 4 | Engine_as — 2:37:00  2/21/2016 12:00:00 AM 2/21/2016 2:37:0(
W’ Trigger on [Any Input =t [—Egres — 2:42:00 | 2/21/2016 12:00:00 AM 2/21/2016 2:42:00
=+ | = Engne_29 —_— 2:42:00  |2/21/2016 12:00:00 AM 2/21/2016 2:42:01
[ Engine_11 Modified:5/26/2016 11:32:10 AM. Version: 1/1/1970 12:00:00 AM, P b= Engne_28 }—| 2:44:00 212112016 12:00:00 AM 22112016 2:43:00
=+ | Engne 74 ] 2:45:00 | 2/21/2016 12:00:00 AM 2/21/2016 2:45:0(
® ¢ | Engne_23 —_— 2:47:00  2/21/2016 12:00:00 AM 2/21/2016 2:47:0(
B+ | —Engne 12 —_— 2:49:00 | 2/21/2016 12:00:00 AM 2/21/2016 2:49:0(
®+ | = Engne_37 _ 2:49:00  |2/21/2016 12:00:00 AM 2/21/2016 2:49:0(
2 s = Enne 6o b 2:51:00 2/21/2016 12:00:00 AM 221/2016 2:51.00%
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Step 2
Pl Integrator to publish Event View
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Pl Integrator for Business Analytics - Select Data

Engine Failure Data by Event del

e Create a Pl Event View Select Data > Modify View > Publish
p u b I is h ed a S a text 'ﬁ | e . H4 Source Events T, Search Shape + Matches

Server CHERTLER7450 T Event Shape Found 100 Matches
4 vy 3 » " Engine_39
13 ” Database Engines =] "4 Engine Failure £ R
i Select Data ) Engine S » " Engine_91
[ Y | Enfer Event or sir | » ¥4 Engine. 70
° Eve nt F rames Event Frames Assets ~ : :: Engiﬂe_g,?
& Engine_24

* Asset Template b 3 Engine. b 3 Engie._58

. » "d Engine_10 » " Engine_8
L4 Attrl b uteS » 4 Engine_100 » M3 Engine_65
» "8 Engine_1 % Asset Shape n » "2 Engine_20
» " Engine_12 4 Qengie s x » "3 Engine_77
» "d Engine_13 & Runtime /% » " Engine_93
» " Engine_14 & status ;% » "4 Engine_27
» "8 Engine_15 P ;% » "4 Engine_98
» "d Engine_16 & 510 ;% » "2 Engine_36
» "8 Engine_17 &sh ;% » " Engine_19
» "d Engine_18 &2 ;% » "4 Engine_45
» "4 Engine_19 & 513 S XV » "4 Engine_13

» "4 Engine 2
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Pl Integrator for Business Analytics — Modify View

 Create a Pl Event View
published as a text file.

« “Select Data”

Edit Value Mode

O summarized Values

e Event Frames

L] Sampled Values

* Asset Element ©sammie s v 1 - | vt |
. Interpolate
* Attributes Oeaci®

O Use Key Column
* “Modify View”
*  One minute samples

t@ OSlsoft. © Copyright 2016 OSlsoft, LLC



Pl Integrator for Business Analytics — Publish

e Create a Pl Event View Select Data > Modify View > Publish

pu b I is h ed aS a teXt fi Ie. Target Configuration Summary
| | Shape and Matches
i “SeleCt Data 7 ® Run Once ¢ [here e 100FMsiching Instances

— Timeframe and Interval
O Run on a Schedule

* Event Frames Vot e et gets an nterpolted
measurement Every 1 minute
e Asset Element

* Attributes L e
* “Modify View”
*  One minute samples

e “Publish”
* Create text file

© Copyright 2016 OSlsoft, LLC




Step 3
R script to derive predictive analytic
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R Script Summary - Review Engine Dataset

id cycle  s1 518 511 512 513 s14 515 s16 s17 s18 s19
Engine_39 0 518.67

. - o
Eng.‘"" T 4 ci0 &7 — —
Eng .
engl| sapply(e, sd) #sdev for each variable
Eng:
Eng
Eng .
eng | id cycle sl 510 s11
E"g- ## 2.922763e+01 6.888099e+0140.000000e+00]0.000000e+00)2.670874e-01
ng.
eng | H# 512 513 514 15 516
E"g" ## 7.375534e-01 7.191892e-02 1.907618e4+01 3.750504e-0210.000000e4+00
ng
eng | ## 517 518 319 52 520
E"g: ## 1.548763e+0000.000000e+00Q0.000000e4+00)5.000533e-01 1.807464e-01
ng.
eng | ## 521 53 s4 55 56
E:g ## 1.082509e-01 ©€.131150e+00 9.000605e+0000.000000e+00)1.388985e-03
Eng; ## s7 =38 =39 settingl setting2
E:g ## 8.850923e-01 7.098548e-02 2.208288e+01 2.187313e-03 2.930621e-04
eng  H# setting3
Eng.| 44 (0.000000e+00
Eng
Eng...—
Engine_39 =
Engine_39 27 518.67 ting1
Engine 39 28 sig.67  Scwing
Engine_39 29 518.67 setting2

s2

0.8

0.6

04

.72
.61
.26
.46
.31

.65

.13
A3
.76
.53
.98

.97
.87
.73
.89

Qo

s3 s4 s5
23.2947 1592.37 1410
23.4604 1586.25 1407.99
23.2669 1586.25 1407.48
23,3789 1587.9 1405.23
23.3338 1587.08 1408.78
23.3029 1592.86 1405.05
23,2378 1596.39 1406.06
23.3534 1592.81 1483.31
23,2386 1592.98 1406.26
23.2466 1596.41 1402.45
23.3439 1588.85 1409.87
23.29 1585.95 1415.5
23.1684 1585.78 1402.06

722 A2 1Ka? A2 1412 Q2
Engine failure
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R Script Summary — Remaining Useful Life

Remaining Useful Life (RUL) = (Event Frame Duration — Cycle) + 1
(Example, for engine (id) 1: 191- 1-1)

id “] cycle 511 512 513 s14 515 517 52 520 521 53 54 sh 7 58 59 settingl setting2 rul
1 1 4747 521.7 2388 8139 85419 392 D418 39.00 2342 1590 1401 21.81 5544 2388 9040 -0.0007 -0.0004 191
1 2| 4749 5223 2388 8131 8.432 392 | 0421 39.00 2342 1592 1403 21.61 5538 2388 09044 00019 -0.0003 180
1 3| 47.27 5224 2388 8133 5418 390 G424 38.9% 2334 1538 1404 21.81 5543 2388 9053 -0.0043 0.0003 159
1 414713 5229 2388 8134 8.368 392 | 0424 38.88 2337 1583 1402 21.61 5545 2388 9040 Q.ooo7 Q.o0o0 183
1 5)47.28 5222 2388 8134 5429 393 £424 3800 2340 1583 1406 21.61 5540 2388 0055 -0.0019 -0.0002 187
1 04716 521.7 2388 8133 8411 391 | D421 3898 23.37 1584 1398 21.61 5547 2388 9050 -0.0043 -0.00017 180
1 7|47.30 5223 2388 8132 8.397 392 0425 38.10 2338 1592 1398 21.81 5543 2388 9059 Qo010 .ooom 185
1 5 |47.24 5225 2385 8131 8.408 391 | G426 38.97 23.31 1583 1401  21.61 553.9 2388 904 -0.0034 0.0003 154
1 o )47.20 521.8 2388 8126 8373 392 G421 39.0% 2341 1591 1385 21.81 5537 2388 9046 0.0003 Q.ooom 183
1 10 §47.03 521.8 2388 8120 8420 393 | 641.7 3805 2347 1591 1400 2161 5536 2388 0052 -0.0033 0.ooom 182
1 11 4715 521.4 2388 8141 5434 392 0423 38.94 2348 1582 1401 21.81 5545 2388 9050 0.oo01sE -0.0003 181
1 12 |47.18 521.8 2388 8134 8.394 391 | 0421 39.00 23.37 1583 1400 21.61 5545 2388 9049 00014 Q.oooz 180
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R Script Summary — Principal Components

Extract principal components

e.odd.pca = prcomp(e.odd.obs, scale = T, center = T) #fit principal components (PC), use only odd engine data

su
# get pcl equation

n

pcleq =
t# for (j im 1:17) {
##
##
##
##

pcleq = cat(sep = "", pcleqg, "+(",

myn
r

names (e.odd.pcascenter[j]), "', "—(",

e.odd.pcaScenter([j], ")", ")/", e.odd.pcasscale[]j], "*", e.odd.pcasrotation|j,
1])

#i

#4
gg| ## +('s117-(47.51488))/0.2701003%0.3090913+("512"'-(521.4901))/0.7517117%-0.3045236+('513"-(2388.09))/0.07484883*

44 0.2845465+('s14'—(8143.502))/19.7965%0.04163657+('s15"-(8.438634))/0.03782789%0.2868222+("'s17'-(393.0714)) /1.5619
§4 64%0.2685557+ ('a2"'—(642.638)) /0.5043607%0.2734667+('s20"—(38.83337))/0.1812555%-0.2819219+ ('s21'—(23.29963))/0.10
#% 838724-0.2834525+('s3'—(1590.048))/6.186916%0.2604444+ ("s4'—(1408.104))/9.077463%0.3006121+("'s6'—(21.60976))/0.00
#f 1539259+0.06360376+('s7'—(553.4522))/0.8983562%-0.2995252+('s8'—(23858.091)) /0.07388822%0.2847322+("'=s9"'- (9064 .65
1))/22.72082*%0.08204075+ ('settingl'-(-3.554925e-05))/0.002184843*0.003580013+('setting2'-(5.022518e-06))/0.000293
1995+0.,003136759
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R Script Summary — Predictive Approach

Calculate pclin real time
for each engine.

If pc1is greater than a
limit of 6.5, post warning
in digital state tag.

RUL (remaining useful life) for Engines 1, 2 and 3

32
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Step 4
Pl Analytics to test and operationalize analytic
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Operationalizing in AF Analytics

Copy R model into
Engine analysis template.

Use AF Analytics to scale
up model for all 100
engines.

Backfill calculation, trend
Status and Predicted
Status attributes check
for sufficient advanced
warning.

MName  Expression Value Output Attribute

zpcl  |+('s11'-(47.51488))/0.2701603%6. 3090013 +( s12" - (521.4901))/0.7517117% 0. 3640236+ ( '513'—(2388.99[‘ ‘pﬂ ‘@L
+('511'-(47.51488))/€.27681083%@. 3090913+ ( '512° —(521|.4981) )/8.7517117*%-6.3849236+( 's13" - ~
(2388.09))/0.07484833%0. 2845465+ ( 's14"-(8143.502) )/19.7965%0.084163657+( 's15"-(8.438634))/0.03782739%0. 2868222 EI

+("s17"-(393.0714))/1.561064%0. 2685557+( 52" - (642.638))/0.5043607%0.2734667+( " 520" -
(38.83337))/0.1812555%-0.2819210+( ' 521"~ (23. 29953});@ 1083872%-0.2834525+( 53" (1599 848))/6.186016%8 . 2604444 M P

\f'ca' f4A08 104NN L0 _ATTACIEAD DANEANALL ' cE ' (01 _cnnTe A\ fA_nATCinarn&n ncienaTe. =
| m |
zpc2 |+ settingl’-(-@.@0083555))/0.002185%0.00467+( setting2 - (0.080005023))/0. 000293270, 005AG5+( 2 - b2 ®
pema3  [(zpcl + PrewVal('pcl',"*")+PrewWal('pcl’,PrevEvent('pcl’, " *')))/3 pemad ®
if pcma3»6.5 B
Failure|then "Will Fail™ Predicted Status ®
else "Ok" v
@ Trend = I='-
Start Tme: [2/20/2016 11:59 FM =]+ | EndTime: [2/21/2016 7:00 am =] |4=-H =0|
® Engine_29|Predicted Status O Engine_29|Status
will Fail
13
0.9
0.8
0.7
.6
.5
4
3
0.2
0.1
g o
2/20/2016 11:59:00 PM 7.02 hours 2/21/2016 7:00:00 AM

Add Attributes... | [ AddPIPoints... | [ Traces.. | [ dlose
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Step 5
Power Bl Desktop to evaluate analytic
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Evaluating the Prediction for All 100 Engines

Q@ g E - o
M M File Search View Go Tools Help
[ ]
S e tre n I n g to O I n @ Database [} Query Date - ® @ @ Back &) ®, Checkin *J v [#] Refresh (F New Element + il New Attribute [ Search Etements p v
Elements Engine_1
& Elements ~ || General child Elements Attributes Ports  Analyses Version
ys e I I l Xp O re r O © Engine_1 Excluded attrbutes are hidden. Group by: [/] Category [] Tempiate
& Engine_10 T v
@ Engine_100 e L ‘
I t & Engne_11 [#t//& 8 name = vake &l
eva u a e O n a n & Engine_12 = & 14272 °R
@ Engine_13
@ Engine_14 = & s5 14.62 psa
engine-by-engine basis e - o~
- - ngine_1
g y g . & cins 17 = g 551.25 psa
@ Engine_18 L] & 8 2388.32 rpm Start Time: |2/20/16 11:59 pm * | End Time: 2/21/16 7:00 am = - =
§oee T T W |
5 - & s10 13 ' st
. @ Engine_20
* Pl Integrator with Power )
& Engine_22 - & s12 5 3
@ Engine_23 b
. @ Engine_24 s & 13 2
Bl Desktop provides a s a0 e
g Engine_26 = Fss 85113
Engine_27
M @ Engine_28 - & s16 0.03
much more efficient I -
© Engine_3 s Fsi8 2388 «
@ Engine_30
& Engine_31 - & 519 100
a p p ro a C h & Engine_32 s g0 38.48
. @ Engine_33 L] & s21 22.9649
@ Engine_34 £
@ Engine_35 B - Category: Engine Setting
& Engine_36 = settngl 0.0009
@ Engine_37 s
@ Engine_38 /: i o - . E
L] setting3 100 -
& Engine_39 s 2/20/2016 11:59:00 PM 7.02 hours 2/21/2016 7:00:00 AM
& Engine_4 B Category: Engine Status
& Engine_40 8¢ | Rmtme 152 Add Attributes... | Add PIPOInts... | Traces... Close
@ Engine_41
@ Engine_s2 = & Status Stopped
& Engine_43 ¥ |[|8 < Category: Falure Prediction
& Elements B¢ & 7.81350565
|~ Event Frames e Fop2 3.61814022
| Library 8¢ & pma3 7.81350565
=3 Unit of Measure B¢ | ¢ Predcted St.. WilFal
Analyses v

[s13
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Evaluating the Prediction for All 100 Engines

Select Data > Modify View » Publish I
~

&) Source Assets %, Search Shape ' Matches
Server CHERTLER7450 % Asset Shape Found 100 Matches
” ’
Database Engines ) Engine 4 % > @Engned
& Predicted Status P » @ Engine_10 Visualizations
@ Assets
& Status # % » @D engine_100
€ Engine_1 ~ » @ Engine_1t
r - —
e Engine_10 &3
) » @ Engine_12 TimeStamp Engine 4 Predicted Status Status ]
@ Engine_100 » € Engine_13 2/21/2016 3:03:00 AM Engine_1  Will Fail Running
e Engi N 2/21/2016 3:04:00 AM  Engine_1 Will Fail Running
= » © Engine_14 2/21/2016 305:00 AM Engine_1 Wil Fal Running
© Engine_12 2/21/2016 3:06:00 AM Engine_1  Will Fail Running TimeStamp
- » @ Engine_15 2/21/2016 3:07.00AM Engine_1  Will Fail Running e
) Engine_13 2/21/2016 3:08:00 AM Engine_1  Will Fail Running
> @ Engine_16 2/21/2016 3:09.00 AM Engine_1  Will Fail Running
& Engine_14 » @ Engine_17 2/21/2016 3:10.00 AM  Engine_1 Wil Fail Running
© 2/21/2016 3:10:00 AM  Engine_100  Will Fail Running ——
SRR e » @ Engine_18 2/21/2016 3:11:00 AM _ Engine_100 _ Wil Fail Running
© Engine_16 2/21/2016 3:1200 AM _ Engine_100  Will Fail Running
. » @ Engine_19 2/21/2016 3:13:00 AM  Engine_100  Will Fail Running =
€ Engine_17 2/21/2016 3:14:00 AM _ Engine_100  Will Fail Running < not Engine_10
© » @ Engine_2 | 2/21/2016 3:15:00 AM  Engine_100 Wil Fail Running | Fiter Type
Engine_18 2/21/2016 3:16:00 AM Engine_100  Will Fail Running
3
@ Engine_20 2/21/2016 3:17:00 AM _ Engine_100  Will Fail Running
© engine_19 » @ Engine_21 2/21/2016 3:18:00 AM _ Engine_100 Wil Fail Running
€ Engine_2 2/21/2016 3:56:00 AM  Engine_11  Will Fail Running
g » @ Engine_22 2/21/2016 3:57.00 AM Engine_11  Will Fail Running
&) Engine_20 2/21/2016 3:58:00 AM  Engine_11  Will Fail Running
o » @ engine_23 2/21/2016 2:3%.00 AM  Engine 12 Will Fail Running
Engine_21 2/21/2016 2:40:00 AM  Engine_12  Will Fail Running
) » © Engine_24 2/21/2016 2:41:00 AM Engine_12  Will Fail Running
© » @ Engine_25 2/21/2016 2:42.00 AM  Engine_12  Will Fail Running
@ engine_23 2/21/2016 2:43:00 AM Engine_12  Will Fail Running
S » @ Engine_26 2/21/2016 2:44:00 AM  Engine_12  Will Fail Running
© Engine_24 2/21/2016 24500 AM  Engine_12  Will Fail Running
» @ Engine_27 2/21/2016 2:46:00 AM  Engine_12  Will Fail Runining TimeStama(All
@ Engine_25 » @ Engine_28 | Zeveoi624no0 A engine.12 W_iH Fail Running |
e Engine_26
v
8 Engine_27
Pagel | Poge2 OB
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Evaluating the Prediction for All 100 Engines

* Use the PI Integrator for o e = = -
BA to create a second T
dataset containing the
Status and Predicted D o
Status for all engines.

graph in Power Bl
showing the amount of
lead time the prediction
gives before actual
failure occurs.

B S o > e
e C(Create afiltered bar
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Useful Links

Microsoft Power Bl Desktop
https://powerbi.microsoft.com/en-us/downloads

Microsoft R Application Network
https://mran.microsoft.com

Power Bl Custom Visuals
https://app.powerbi.com/visuals
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https://powerbi.microsoft.com/en-us/downloads
https://mran.microsoft.com/
https://app.powerbi.com/visuals

Contact Information

Curt Hertler
curt@osisoft.com

Global Solutions Architect
OSlsoft
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